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Introduction

This model presents a practical and efficient method to compute the sound transmission
loss (STL) through a building component, specifically this example treats the case of a
concrete wall. The method, used here, is valid as long as the component has little influence
on the acoustic field on the source side. The method is based on assuming an ideal diffuse
field on the source side and an ideal anechoic termination on the receiver side of the
concrete wall. In typical measurement setups, the diffuse sound field is generated in a
reverberation room. At low frequencies, the fields that you can obtain are less than
perfectly diffuse. The measured STL will therefore to some extent depend on the
experimental conditions. From the approach used in this model, you can extract an ideal,
experiment-independent STL. The obtained results are compared to published

experimental data and shows good agreement.

Model Definition

In this tutorial, the sound transmission loss (STL) through a concrete wall will be modeled
using an approach that is well suited for numerical simulations. A review of STL
measurement techniques and theory is given below in order to motivate the simulation

approach used here. Following this discussion, the method is described in detail.

SOUND TRANSMISSION LOSS (STL)
The STL through a building component, like a door, a window, a wall segment, or a sound
insulation structure, is defined as the ratio of the total incident power Pj,, on the structure,

relative to the total transmitted power Py, (measured on the dB scale),

P in
STL = 1010 2 (1)
tr

The STL is defined for conditions where the acoustic field on the source side is a diffuse
acoustic field. Several standards exist for the measurement of the STL, for example, ASTM
E90 or ISO 10140. Common to the methods is that they are devised in order to directly
or indirectly measure the incident and transmitted power using various methods. Typically,
a so-called two-room method is used. The two most common configurations both use a
reverberation room on the source side. The first also uses a reverberation room on the
receiver side (reverberant-reverberant) while the second uses an anechoic room on the

receiver side (reverberant-anechoic). The two configurations are sketched in Figure 1.
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Figure 1: The two variations of the two-room configuration for measurving the sound
transmission loss: (top) both source and receiver reverberation rooms, and (bottom) the source
reverberation room and receiver anechoic room.

Y.

anechoic treatment

In both cases, the incident power on the source side is computed as

2
Pin _ prmssS (2)
4pc

where Sy is the area of the test surface on the source side (the area of the concrete wall
tested), ppmg is the RMS pressure in the source room, p is the density, and ¢ is the speed
of sound. This expression is derived by considering the incident power on a surface in an
ideal diffuse acoustic field, see Ref. 1 and Ref. 2.

The expressions used to compute the incident and transmitted power for the reverberant-
reverberant case are only valid as long as the acoustic field is diftuse. A measure for the

transition from modal to diffuse behavior is given by the Schroeder frequency
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where V is the room volume and T is the reverberation time; see Ref. 1. A room of
volume V is said to be acoustically large when the studied frequency £ is larger than the

Schroeder frequency, giving the condition

v (2091 Ty @)

f

Reverberant-Reverberant Setup
In the setup where also the receiver room is a reverberation room (Figure 1 top) and the

sound field is assumed diftuse, the transmitted power is given by

2
Pus ek A= XS ®
l
where pym is the RMS pressure in the receiver room and A, is the receiver room
absorption, that is, the product of each area S; and its absorption coefficient o;. The
expression stems from an energy balance consideration, that is, the total absorbed energy
is equal to the radiated energy of a source. Combining Equation 2 and Equation 5 gives

the expression for the STL for the reverberant-reverberant setup
SS
STL = SPL, - SPL, - 10log;(5’) ®)
r

where SPLg and SPL,. is the average sound pressure level in the source and the receiver
room, respectively. Averaging is of course done on the RMS pressure before transforming
to the dB scale.

Note that a correction to Equation 5 is sometimes introduced (it is based on the
Waterhouse expression). At walls (in a room with a diffuse field), the RMS pressure will be
larger by a factor 2, because the incident and reflected fields are correlated, see Ref. 2. The

expression reads

2
P Pmsy (1 . Sr,moml) 13.8 @
tr pc2 r 8Vr 7’c

where T is the early decay time, V. is the receiver room volume, S}. ;oor, the receiver room
.

surface area, and A is the wavelength.
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Reverberant-Anechoic Setup

In the reverberant-anechoic configuration (Figure 1 bottom), the transmitted power is
directly measured on the receiver side using an intensity probe. The measurement is
performed in several locations in front of the test element and averaged. The transmitted

power is then simply given by

P =81 (8

tr rtr

combining this expression with Equation 1 and Equation 2 gives

S
STL = SPL, - SIL, + 10logy( ') - 6.14 )
r
for flat samples Sg = S and SILy, is the transmitted (measured) sound intensity level. The
numeric constant stems directly from the definitions of SPL and SIL and the equations

for the power, it is expressed as

2
P
101og10&752ff51;j ~6.14 (10)
Ie

where prer=20 pPa, I ¢ = 10712 W/m,p =12 kg/m3, and ¢ = 343 m/s.
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Figure 2: Schematic representation of the frequency dependency of the STL for panels made of
isotropic materials.

ESTIMATION MODEL FOR THE STL
The STL for panels (like the wall studied here) has a general frequency dependent behavior
that is sketched in Figure 2 for the case of isotropic elastic materials (see Ref. 3). At low
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frequencies, below the first mechanical (panel) resonance f7; of the structure, the STL is
stiffness controlled. At and around the resonance the STL drops drastically as the structure
acts as an optimal transmitter (dips can also occur for the second mode). Above the first
resonance the STL becomes mass controlled. This is in a relatively large frequency band
where the STL increases with 6 dB per octave. Then at the critical frequency £, in a region
called the coincidence region, the STL decreases. Coincidence happens when the
wavelength of the pressure waves in the fluid are comparable to wavelength of the flexural
waves in the structure. Above this region the STL increases. It is first damping controlled

(9 dB per octave) before it approaches the mass law behavior again.

Several analytical perdition models exist for the STL for a simply supported panels (plastes
or walls), see Ref. 3. In the mass law region one model, called Sharp’s equation (for 1/3
octave STL values), is given as

STL = 10logy,(1+ ("F’:—’f)z) ~5.5dB 1D

where m = pggp;q-T is the mass per unit area of the structure, pggyiq is the density of the
structure, and T is the thickness of the panel (here the wall, see Figure 3). Note that the
predicted STL from Sharp’s equation will in practice exceed the actual STL. This is because
the equation assumes an ideal limp panel and does not take into account the panel stiftness.
This same trend is seen in the model results discussed below. The slope in the mass law
region will obey the 6 dB per octave trend. A doubling of the wall thickness will double
the value of m and thus results in a 6 dB increase in STL for a given frequency.

IDEAL MODEL SETUP

When simulating the STL we want to avoid having to model the source and receiver rooms
as this would be computationally extremely expensive. Instead the setup is based on
assuming an ideal diffuse field on the source side and an ideal anechoic termination on the
receiver side of the test sample (here a concrete wall). Experimentally measured STL values
will to some extent depend on the experimental conditions. The model also assumes that
the test sample has little influence on the sound field on the source side. This is true for
relatively stiff structures with low acoustic absorption properties. This is the case for the
concrete wall studied in this example. In this case the sound field on the source side (the
source room) can be defined as a sum of N uncorrelated plane waves moving in random

directions. The source room pressure field is then
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N

1 . .
Proom = fv Z eXp(_l(kn,xx +kn,yy +kn,zz))exp(lq)n)
n=1

k., = cos() 12)

n,x

>
Il

ny sin(0,)cos(9,)

kn’y sin(0,)sin(@,)

where the polar angles 6, and ¢, , and the phase @, are independent random numbers.
In the model, a new set of random numbers is generated for cach n in the sum. The 1/ /N
term ensures that the field has a constant intensity for any choice of N. The theoretical
limit, for large N, of the average RMS pressure in the room (measured away from walls)
will then be p_ = 1/./2 Pa.

At the concrete wall (placed in the x = 0 plane), the diffuse field is reflected. The reflected

component of the field is

N
Pug = ]%r S exp(-i(-k, x+ky y +E, 2)expiD,). 13)

n=1

The reflected field is coherent with the incident field (as discussed for Equation 5). At the
surface of the concrete well, the total pressure load applied to the structure is the sum of

the diffuse room pressure and the reflected pressure
Pyall = Proom T Prefl (14)

In the model, the room pressure, the reflected pressure, and wall pressures are defined as

global variables.
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Figure 3: Model setup of o concrete wall with an ideal diffuse field on the source side and an
ideal anechoic termination on the receiver side.

The wall pressure py,,11 is applied as a load on the source side of the concrete wall. On the
receiver side, a perfect anechoic room is modeled using an air domain terminated by a
perfectly matched layer (PML). The model setup is sketched in Figure 3.

The concrete wall has a height of H = 4.37 m, a width of W = 2.84 m, and a thickness of
T =203 mm. The density of the concrete is pgo, = 2275 kg/ ms, the Young’s modulus is
E.,, = 31.6 GPa, the Poisson ration is 0.2, and a typical value of 0.01 is used as the
isotropic loss factor. The wall size and material data is taken from the test configuration
called 76-77 described in Ref. 4. The wall is assumed fixed at its outer boundary and

placed in an ideal surrounding wall that does not contribute to the STL.

Note that the fixed constraint used here is different from the “simply supported”
condition (a hinge-like condition) often used in the analytical prediction models. To
precisely predict measurements or model the behavior of building components in-situ a
good description of the outer boundary conditions is of course required. The condition
used will, for example, have a significant influence on the low frequency stiffness
controlled behavior of the STL.
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Results and Discussion

The incident intensity distribution on the concrete wall is depicted in Figure 4, evaluated
at 100 Hz, 250 Hz, 500 Hz, and 1000 Hz. The distribution is not dependent on the
solved model but only on the randomness and number of terms in the expression for the

room pressure room pressure field p,oom from Equation 12.
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Figure 4: The incident intensity evaluated in the concrete wall surfiuce.

The incident intensity on the half space (in the x-direction) is computed using its definition
as

11
x,in = ééRe(proomv*x, room)

(15)
=1 %Proom
Uy room = @ ox

where the extra factor 1/2 is necessary as it is only the incident component of the room
field that should be used (half space contribution). The spatial distribution of the
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transmitted (radiated) intensity is depicted for the same frequencies in Figure 5. The

transmitted intensity depends on the solved problem and is computed as

I . = %Rc(pt(iwu)*) (16)

x,

where p; is the total acoustic pressure and « is the structural displacement in the
x direction. Both variables are solved for in the model.
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Figure 5: The transmitted intensity evaluated on the concrete wall surface.

The displacement of the concrete wall, as well as the pressure in the receiver room, is
depicted in Figure 6 for the same four frequencies. At the low frequencies, the

displacement distribution is strongly dictated by the possible modes of the structure.
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Comparing this to Figure 5 it is also evident that the transmitted intensity field is
controlled by the displacement.
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Figure 6: The displacement of the concrete wall and the pressure on the receiver side.
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The sound transmission loss (STL), computed using Equation 1, Equation 2, and
Equation 8, is depicted in Figure 7 and Figure 8. The STL is depicted as a continuous line
(evaluated for all the computed frequencies) as well as in octave bands or 1,/3 octave
bands, respectively. Both graphs also include the typically measured STL. The data is
adapted from Ref. 4 and shows good agreement.

In Figure 7 the estimated STL using Sharp’s equation (see Equation 11) is also depicted
in the region where the mass law applies. The estimate shows the same trend with the
correct slope (6 dB per octave) but overestimates the STL. This is expected as Sharp’s
equation assumes a limp structure and does not include the stiffness effects.

The dips in the STL curve correspond to the first two structural modes which are depicted
in Figure 10. They occur at f11 = 113 Hz and f15 = 170 Hz. Below these frequencies the
STL is stiffness controlled and depends highly on the boundary conditions applied to the
structure. The mass law behavior applies above these.
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Figure 7: Sound transmission loss (STL) through the concrete wall with octave bands.
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Figure 8: Sound transmission loss (STL) through the concrete wall with 1/3 octave bands.
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Finally, Figure 9 depicts the incident power on the wall computed using three different
methods. The blue graph shows the value given by the surface integral of Equation 15.
The green graph represents the value given by Equation 2 where the RMS pressure is
given as the average of ppom Over the wall surface. The red graph is also computed using
Equation 2 but with the RMS pressure set to the theoretical value p - = 1/ J2 Pa.The
graphs indicate the expected large fluctuations at low frequencies where the wavelength is
comparable to the wall size. In measurement conditions the field would also not be diffuse

at these low frequencies.

Incident Power: Three Computation Methods
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Figure 9: The incident power on the wall evaluated using three different methods.
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Figure 10: The first three modes of the structure.

Notes About the COMSOL Implementation

The model is based on several assumptions:

¢ Perfect diffuse field in the source room.
e Perfect anechoic behavior in the receiver room.
¢ The structure under analysis has a negligible influence on the source room acoustic

field. This means that structure is stiff and has low absorption.

If the test sample does not meet the last requirement, then the source field acoustics needs
to be solved coupled with the structure. This can of course also be done.
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Application Library path: Acoustics_Module/Building_and_Room_Acoustics/
sound_transmission_loss_concrete

Modeling Instructions

From the File menu, choose New.

NEW
In the New window, click Model Wizard.

MODEL WIZARD
I In the Model Wizard window, click W 3p.

2 In the Select Physics tree, select Acoustics>Acoustic-Structure Interaction>Acoustic-

Solid Interaction, Frequency Domain.
Click Add.
Click e Study.

In the Select Study tree, sclect General Studies>Frequency Domain.

Click El/ Done.

o U1 A W

GLOBAL DEFINITIONS

Parameters |
I In the Model Builder window, under Global Definitions click Parameters I.

2 In the Settings window for Parameters, locate the Parameters section.

3 Click Load from File.
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4 Browse to the model’s Application Libraries folder and double-click the file
sound_transmission_loss_concrete_parameters.txt.

Create an interpolation function that contains typical measurement data of the STL for
the concrete wall.

Interpolation | (intl)

I In the Home toolbar, click f(x) Functions and choose Global>Interpolation.
In the Settings window for Interpolation, locate the Definition section.

2
3 From the Data source list, choose File.
4 Click Browse.

5

Browse to the model’s Application Libraries folder and double-click the file
sound_transmission_loss_concrete_measurement_data.txt.

6 Find the Functions subsection. In the table, enter the following settings:

Function name Position in file

STL_typical 1

7 Click Import.

8 Locate the Interpolation and Extrapolation section. From the Interpolation list, choose

Piecewise cubic.
9 Locate the Units section. In the Arguments text field, type Hz.

10 In the Function text field, type dB.

GEOMETRY |

Block I (blkl) )

I In the Geometry toolbar, click [ Block.

2 In the Settings window for Block, locate the Size and Shape section.
3 In the Width text field, type T.

4 In the Depth text field, type W.

5 In the Height text field, type H.

Block 2 (blk2) )

I In the Geometry toolbar, click [ Block.

2 In the Settings window for Block, locate the Size and Shape scction.
3 In the Width text field, type 3*T.

4 In the Depth text field, type W+4*T.
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5 In the Height text field, type H+4*T.

6 Locate the Position section. In the x text field, type T.
7 In the y text field, type -2*T.

8 In the z text field, type -2*T.

9 Click to expand the Layers section. In the table, enter the following settings:

Layer name Thickness (m)

Layer 1 T

10 Find the Layer position subsection. Select the Right check box.
11 Select the Front check box.

12 Select the Back check box.

13 Select the Top check box.

14 Select the Bottom check box.

I5 Click [E8 Build All Objects.

PRESSURE ACOUSTICS, FREQUENCY DOMAIN (ACPR)

I In the Model Builder window, under Component | (compl) click Pressure Acoustics,
Frequency Domain (acpr).

17 | SOUND TRANSMISSION LOSS THROUGH A CONCRETE WALL



2 Select Domains 2—-19 only.

SOLID MECHANICS (SOLID)

I In the Model Builder window, under Component | (compl) click Solid Mechanics (solid).
2 In the Settings window for Solid Mechanics, locate the Domain Selection scction.

3 Click !?:—_Ij Clear Selection.

4 Select Domain 1 only.

MULTIPHYSICS

Acoustic-Structure Boundary | (asbl)
Click the @ Wireframe Rendering button in the Graphics toolbar.

y,\I/X

MATERIALS

Add Material

From the Home menu, choose Add Material.

ADD MATERIAL
I Go to the Add Material window.

2 In the tree, select Built-in>Air.
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3 Click Add to Component in the window toolbar.

4 From the Home menu, choose Add Material.

MATERIALS

Concrete
I In the Model Builder window, expand the Multiphysics node.

2 Right-click Component | (compl)>Materials and choose Blank Material.
3 In the Settings window for Material, type Concrete in the Label text field.
4 Select Domain 1 only.

5 Locate the Material Contents section. In the table, enter the following settings:

Property Variable Value Unit Property group
Young’s modulus E 31.6e9 Pa Basic

Poisson’s ratio nu 0.2 I Basic

Density rho 2275 kg/m? Basic
DEFINITIONS

Variables: Diffuse Field
I In the Model Builder window, under Component | (compl) right-click Definitions and
choose Variables.

2 In the Settings window for Variables, type Variables: Diffuse Fieldin the Label text
field.

3 Locate the Variables section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file
sound_transmission_loss_concrete_variables_diffuse.txt.

Variables: STL

I In the Model Builder window, right-click Definitions and choose Variables.

2 In the Settings window for Variables, type Variables: STL in the Label text ficld.

3 Locate the Variables section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file

sound_transmission_loss_concrete_variables_stl.txt.

Random | (rnl)

I In the Home toolbar, click f(x) Functions and choose Local>Random.
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2 In the Settings window for Randem, type costheta_rnd in the Function name text field.
3 Locate the Parameters section. In the Number of arguments text field, type 4.

4 In the Mean text field, type 0.5.

Random 2 (rn2)

I In the Home toolbar, click f(x) Functions and choose Local>Random.

2 In the Settings window for Random, type phi_rnd in the Function name text field.

3 Locate the Parameters scction. In the Number of arguments text field, type 4.

4 In the Mean text field, type pi.

5 In the Range text field, type 2*pi.

Random 3 (rn3)

I In the Home toolbar, click f(x) Functions and choose Local>Random.

2 In the Settings window for Random, type phase_rnd in the Function name text field.

3 Locate the Parameters section. In the Number of arguments text field, type 4.

4 In the Mean text field, type pi.

5 In the Range text field, type 2*pi.

Integration | (intopl)

I In the Definitions toolbar, click 0/) Nonlocal Couplings and choose Integration.

2 In the Settings window for Integration, type intop_in in the Operator name text field.

3 Locate the Source Selection section. From the Geometric entity level list, choose

Boundary.
4 Sclect Boundary 1 only.
Integration 2 (intop2)
I In the Definitions toolbar, click 0/) Nonlocal Couplings and choose Integration.
2 In the Settings window for Integration, type intop_tr in the Operator name text field.

3 Locate the Source Selection section. From the Geometric entity level list, choose

Boundary.
4 Select Boundary 26 only.
Save solution on boundaries
I In the Definitions toolbar, click g Explicit.

2 In the Settings window for Explicit, type Save solution on boundaries in the Label
text field.
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3 Locate the Input Entities section. From the Geometric entity level list, choose Boundary.

4 Seclect Boundaries 1-5, 19, 26, and 53 only.

Y\I/'X

Perfectly Matched Layer | (pmll)
I In the Definitions toolbar, click [|/||\* Perfectly Matched Layer.
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2 Select Domains 2-5 and 7-19 only.

0.8

0

3 In the Settings window for Perfectly Matched Layer, locate the Scaling section.

4 In the PML scaling curvature parameter text field, type 2.

SOLID MECHANICS (SOLID)

Linear Elastic Material |

In the Model Builder window, expand the Solid Mechanics (solid) node, then click
Linear Elastic Material I.

Damping |

I In the Physics toolbar, click E, Attributes and choosc Damping.

2 In the Settings window for Damping, locate the Damping Settings section.

3 From the Damping type list, choose Isotropic loss factor.

Remember to go back to the Concrete material and add the value for the isotropic loss
factor.
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MATERIALS

Concrete (mat2)

I In the Model Builder window, under Component | (compl)>Materials click
Concrete (mat2).

2 In the Settings window for Material, locate the Material Contents section.

3 In the table, enter the following settings:

Property Variable Value Unit Property group
Isotropic structural loss  eta_s 0.01 | Basic
factor

SOLID MECHANICS (SOLID)

Fixed Constraint |
I In the Physics toolbar, click m® Boundaries and choose Fixed Constraint.

2 Select Boundaries 2-5 only.

y,\I/X

Boundary Load |
I In the Physics toolbar, click mw Boundaries and choosc Boundary Load.

2 Select Boundary 1 only.
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3 In the Settings window for Boundary Load, locate the Force section.
4 From the Load type list, choose Pressure.

5 In the p text field, type p_wall.

MESH |

I In the Model Builder window, under Component | (compl) click Mesh 1.

2 In the Settings window for Mesh, locate the Mesh Settings section.

3 From the Sequence type list, choose User-controlled mesh.

Size

I In the Model Builder window, under Component | (compl)>Mesh | click Size.
2 In the Settings window for Size, locate the Element Size section.

3 Click the Custom button.

4 Locate the Element Size Parameters section. In the Maximum element size text field, type
c0/fmax/5.

5 In the Minimum element size text field, type c0/fmax/6.

Free Tetrahedral |

I In the Model Builder window, click Free Tetrahedral 1.

2 In the Settings window for Free Tetrahedral, locate the Domain Selection section.
3 From the Geometric entity level list, choose Domain.

4 Seclect Domain 6 only.

Swept |

I In the Model Builder window, right-click Mesh 1 and choose Swept.

2 In the Settings window for Swept, locate the Domain Selection scction.
3 From the Geometric entity level list, choose Domain.

4 Select Domain 1 only.

Distribution |

I Right-click Swept | and choose Distribution.

2 In the Settings window for Distribution, locate the Distribution section.
3 In the Number of elements text field, type 3.

Swept 2
In the Model Builder window, right-click Mesh | and choose Swept.
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Distribution |
I In the Model Builder window, right-click Swept 2 and choose Distribution.

2 In the Settings window for Distribution, locate the Distribution section.
3 In the Number of elements text field, type 8.
4 Click [BE Build All.

y,\I/X

STUDY 1|

Solution | (soll)
I In the Study toolbar, click ™= Show Default Solver.

Once the default solver has been generated, expand the nodes and enable the second
suggested iterative solver. This solver is both faster and more memory efficient than the
default direct solver. It uses a multigrid preconditioner for the acoustic variables and a

direct preconditioner for the solid mechanics variables.
2 In the Model Builder window, expand the Solution 1 (soll) node.

3 In the Model Builder window, expand the Study |1>Solver Configurations>

Solution 1 (soll)>Stationary Solver | node.
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4 Right-click Study 1>Solver Configurations>Solution | (soll)>Stationary Solver 1>
Suggested Iterative Solver (GMRES with GMG and Direct Precond.) (asbl) and choose
Enable.

Step I: Frequency Domain

I In the Model Builder window, click Step I: Frequency Domain.

In the Settings window for Frequency Domain, locate the Study Settings section.
Click I;.ﬂ.J Range.

In the Range dialog box, choose 1SO preferred frequencies from the Entry method list.
In the Start frequency text field, type 35.

In the Stop frequency text field, type fmax.

From the Interval list, choose 1/12 octave.

Click Replace.

NV O N 0 1 AW N

In the Settings window for Frequency Domain, click to expand the

Values of Dependent Variables scction.
10 Find the Store fields in output subsection. From the Settings list, choose For selections.
Il Under Selections, click =+ Add.

To reduce the model size when saved, only store the solution on the selected

boundaries.
12 In the Add dialog box, select Save solution on boundaries in the Selections list.
13 Click OK.
14 In the Study toolbar, click = Compute.

Inspect the default plots generated, you can change the evaluation frequency if needed.
Notice that the isosurface plot is less interesting as we have only stored the solution on

boundaries.
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RESULTS
Acoustic Pressure (acpr)

freq(62)=1180 Hz Surface: Total acoustic pressure field (Pa)

x10™*
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Sound Pressure Level (acpr)

freq(62)=1180 Hz Surface: Sound pressure level (dB)

20

10

-10

-30

-40

-50

Acoustic Pressure, Isosurfaces (acpr)

freq(62)=1180 Hz Isosurface: Total acoustic pressure field (Pa)

x107
= 54.6

== 29.6

4.7
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Stress (solid)

freq(62)=1180 Hz Surface: von Mises stress (Pa)
25
20
15

m 10
5
z
y‘\I/vX

0.5

Next, create plots of the incident and transmitted intensity, the displacement, as well as 1D
plots of the STL.

Incident Intensity

I In the Home toolbar, click @1 Add Plot Group and choose 3D Plot Group.

2 In the Settings window for 3D Plot Group, type Incident Intensity in the Label text
field.

Surface |

I Right-click Incident Intensity and choose Surface.

2 In the Settings window for Surface, locate the Expression section.

3 In the Expression text field, type 0.5*Ix_room.

Selection |

I Right-click Surface I and choose Selection.

2 Select Boundary 1 only.

3 In the Incident Intensity toolbar, click Plot.

The plot is depicted at four frequencies in Figure 4.
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Transmitted Intensity
I In the Home toolbar, click @1 Add Plot Group and choose 3D Plot Group.

2 In the Settings window for 3D Plot Group, type Transmitted Intensity in the Label
text field.

Surface |

I Right-click Transmitted Intensity and choose Surface.

2 In the Settings window for Surface, locate the Expression section.

3 In the Expression text field, type Ix_tr.

Selection |

I Right-click Surface | and choose Selection.

2 Select Boundary 26 only.

3 In the Transmitted Intensity toolbar, click Plot.
The plot is depicted at four frequencies in Figure 5.

Displacement

I In the Home toolbar, click @1 Add Plot Group and choose 3D Plot Group.
In the Settings window for 3D Plot Group, type Displacement in the Label text field.
Click to expand the Title section. From the Title type list, choose Manual.
Select the Allow evaluation of expressions check box.

2

3

4

5 In the Parameter indicator text ficld, type f = eval(freq) Hz.

6 Locate the Plot Settings scction. Clear the Plot dataset edges check box.
7

Locate the Color Legend section. Select the Show units check box.
Surface |
I Right-click Displacement and choose Surface.
2 In the Settings window for Surface, locate the Expression section.
3 In the Expression text field, type solid.disp.

Deformation |
Right-click Surface | and choose Deformation.

Filter |
I In the Model Builder window, right-click Surface 1 and choose Filter.

2 In the Settings window for Filter, locate the Element Selection section.

3 In the Logical expression for inclusion text field, type z>1.5[m].
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Surface 2
I In the Model Builder window, right-click Displacement and choose Surface.

2 In the Settings window for Surface, locate the Coloring and Style section.
3 From the Color table list, choose Wave.
4 Seclect the Symmetrize color range check box.
Selection |
I Right-click Surface 2 and choose Selection.
2 Select Boundary 53 only.
3 In the Displacement toolbar, click Plot.
The plot is depicted at four frequencies in Figure 6.

Postprocessing the STL variables is time consuming, so in order to save time setting up
the next three plots (avoiding automatic plotting when formatting the plots), enable the

Only plot when requested option.
4 In the Model Builder window, click Results.
5 In the Settings window for Results, locate the Update of Results section.
6 Seclect the Only plot when requested check box.
STL: P_in/P_tr (octaves)
I In the Home toolbar, click @1 Add Plot Group and choose ID Plot Group.

2 In the Settings window for 1D Plot Group, type STL: P_in/P_tr (octaves) in the
Label text field.

Click to expand the Title section. From the Title type list, choose Manual.
In the Title text area, type Sound Transmission Loss (octaves).
Locate the Plot Settings section. Select the x-axis label check box.

In the associated text field, type f (Hz).

Select the y-axis label check box.

In the associated text field, type STL (dB).

NV O N o0 1 AW

Locate the Legend section. From the Position list, choose Lower left.

Octave Band |

I In the STL: P_in/P_tr (octaves) toolbar, click " More Plots and choosc Octave Band.
2 In the Settings window for Octave Band, locate the Selection section.

3 From the Geometric entity level list, choose Global.

4 Locate the y-Axis Data section. From the Expression type list, choose Power.
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5 In the Expression text field, type P_in.

6 In the Power reference text field, type P_tr.

7 Locate the Plot section. From the Style list, choose Continuous.

Octave Band 2

I Right-click Octave Band | and choose Duplicate.

2 In the Settings window for Octave Band, locate the Plot section.

3 From the Style list, choose Octave bands.

4 Click to expand the Coloring and Style section. From the Type list, choose Curve.

Global |

I In the Model Builder window, right-click STL: P_in/P_tr (octaves) and choosc Global.
In the Settings window for Glebal, locate the Data section.

2

3 From the Dataset list, choose Study 1/Solution I (soll).

4 From the Parameter selection (freq) list, choose From list.
5

From the Parameter values list select the frequencies from 100 Hz to 1180 Hz, where

the measurements are valid.

6 Locate the y-Axis Data section. In the table, enter the following settings:

Expression Unit Description

STL_typical(freq) Typical Measurements

7 In the STL: P_in/P_tr (octaves) toolbar, click Plot.

The STL plot, with the octave evaluation, is depicted in Figure 7.
STL: P_in/P_tr (1/3 octaves)
I Right-click STL: P_in/P_tr (octaves) and choosc Duplicate.

2 In the Settings window for ID Plot Group, type STL: P_in/P_tr (1/3 octaves) in
the Label text field.

3 Locate the Title section. In the Title text area, type Sound Transmission Loss (1/3

octaves).

Octave Band 2
I In the Model Builder window, expand the STL: P_in/P_tr (1/3 octaves) node, then click
Octave Band 2.

2 In the Settings window for Octave Band, locate the Plot section.

3 From the Style list, choose 1/3 octave bands.
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Global 2

2
3
4
5

In the Model Builder window, right-click STL: P_in/P_tr (1/3 octaves) and choose Global.
In the Settings window for Global, locate the Data section.

From the Dataset list, choose Study 1/Solution 1 (soll).

From the Parameter selection (freq) list, choose From list.

From the Parameter values list sclect the frequencies from 200 Hz to 1180 Hz, to plot

Sharp’s equation here.

6 Locate the y-Axis Data section. In the table, enter the following settings:
Expression Unit Description
10*1og10(1+(pi*freq*m/ (rho0* Sharp's Equation (mass law)
c0))~2)-5.5

7

In the STL: P_in/P_tr (1/3 octaves) toolbar, click Plot.

The STL plot, with the 1/3 octave evaluation and Sharp’s equation, is depicted in
Figure 8.

Incident Power (three methods)

|
2

4
5
6
7
8
9

In the Home toolbar, click @1 Add Plot Group and choose ID Plot Group.

In the Settings window for ID Plot Group, type Incident Power (three methods) in
the Label text ficld.

Click to collapse the Title section. Click to expand the Title section. From the Title type

list, choose Manual.

In the Title text area, type Incident Power: Three Computation Methods.
Locate the Plot Settings section. Select the x-axis label check box.

In the associated text field, type f (Hz).

Select the y-axis label check box.

In the associated text field, type Power: P<sub>in</sub> (W).

Locate the Axis section. Select the x-axis log scale check box.

10 Select the y-axis log scale check box.

Il Locate the Legend section. From the Position list, choose Lower right.

Global |

|
2

Right-click Incident Power (three methods) and choose Global.

In the Settings window for Glebal, locate the y-Axis Data section.

33 | SOUND TRANSMISSION LOSS THROUGH A CONCRETE WALL



3 In the table, enter the following settings:

Expression Unit Description

P_in W Incident power (half space)

P_in_proom W Incident power (room RMS pressure average)
P_in_theo w Incident power (theoretical)

4 In the Incident Power (three methods) toolbar, click Plot.
The power plot is depicted in Figure 9.

Proceed and add a second study to perform an eigenfrequency analysis of the structure
(the wall). When adding the study de-select the acoustic and the multiphysics coupling.
In the analysis setup look for the first 3 modes.

ADD STUDY
I In the Home toolbar, click \O?i Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, sclect General Studies>

Eigenfrequency.

4 Find the Physics interfaces in study subsection. In the table, clear the Solve check box for

Pressure Acoustics, Frequency Domain (acpr).

5 Find the Multiphysics couplings in study subsection. In the table, clear the Solve check
box for Acoustic-Structure Boundary | (asbl).

6 Click Add Study in the window toolbar.
7 In the Home toolbar, click \O?i Add Study to close the Add Study window.

STUDY 2

Step I: Eigenfrequency

I In the Settings window for Eigenfrequency, locate the Study Settings section.

2 Select the Desired number of eigenfrequencies check box.

3 In the associated text field, type 3.

4 From the Eigenfrequency search method around shift list, choose Larger real part.

5 In the Home toolbar, click = Compute.
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RESULTS

Mode Shape (solid)

The first three structural modes are depicted in Figure 10. A table with the eigenvalues is
also automatically generated. To see the table select the Eigenfrequencies (Study 2)
evaluation group node.

Finally, disable the Only plot when requested option for the results. Turn On the option to

Save plot data in order to avoid re-render the STL curves once the model is opened again.

I In the Model Builder window, click Results.
2 In the Settings window for Results, locate the Update of Results section.
3 Clear the Only plot when requested check box.

4 Locate the Save Data in the Model section. From the Save plot data list, choose On.
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